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Installation and Configuration 
The following sections outline how to deploy and configure the Kelverion Integration Module 
Zendesk. 

System Requirements 
The Integration Module for Zendesk requires the following software to be installed and configured 
prior to implementing the integration. For more information on installing Kelverion Runbook Studio, 
please refer to the Kelverion Runbook Studio User Guide.

• Kelverion Runbook Studio 5.6 

• Microsoft .NET Framework 4.7.2 

• Zendesk Subscription through 2023-12-08 

 
The Kelverion Integration Module for Zendesk requires TLS 1.2 support to be enabled on your local 
computer or hybrid worker. Please use SystemDefaultTlsVersions and SCHANNEL\Protocols in the 
Windows Registry to control the version of TLS in use. 

Deploying the Integration Module 
The easiest way to install and deploy the Integration Module for Zendesk is from the PowerShell 
Gallery, but you can also download the module from Kelverion and perform the steps manually. 

You must install and deploy the Integration Module to each Azure Automation Account and Hybrid 
Worker host system that you plan to use to run your runbooks. You must also install the Integration 
Module on any Runbook Studio host systems that you will be using to build and manage your 
runbooks. 

Using the PowerShell Gallery  
Using the commands in the PowerShellGet module, you can download the Kelverion Integration 
Module for Zendesk from the PowerShell Gallery and install it on your local computer. You can also 
deploy the module directly from the PowerShell Gallery to any of your Azure Automation Accounts. 

Install the Integration Module on your local computer or any Hybrid Workers: 

1. Confirm that the latest PowerShellGet module is installed. 

2. Start a PowerShell window as Administrator and run the command: 
Install-Module -Name Kelverion.Zendesk -Scope AllUsers 

  

https://support.zendesk.com/hc/en-us/sections/4405298847002-Release-Notes
https://docs.microsoft.com/en-us/dotnet/framework/network-programming/tls#configuring-security-via-the-windows-registry
https://docs.microsoft.com/en-us/dotnet/framework/network-programming/tls#configuring-schannel-protocols-in-the-windows-registry
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Upload the Integration Module to an Azure Automation Account: 

1. Go to the PowerShell Gallery. 

2. Click the Azure Automation tab. 

3. Click Deploy to Azure Automation. You will be directed to Microsoft Azure. 

4. Select the Automation Account that you want to deploy the module to. 

5. Click OK. 

Manual Installation 
Alternatively, you can download the Integration Module package from Kelverion and deploy it 
manually to your local computer, hybrid workers and Automation Accounts. 

The download package from Kelverion includes a .zip file containing the Integration Module as well 
as the User Guide and Release Notes. The following instructions assume that you have unzipped the 
download package and have access to the .zip file containing the Integration Module. 

Install the Integration Module on your local computer or any Hybrid Workers: 

1. Copy the Kelverion.Zendesk.zip file to your local computer. 

2. Right-click on the file and select Properties.  

3. Click the General tab. If necessary, click Unblock, and then click OK. 

4. Unzip the Kelverion.Zendesk.zip file. 

5. Copy the Kelverion.Zendesk folder to a location in the %PsModulePath% path. 

Important: When installing the Integration Module on a Hybrid Worker, you must use a location that 
is accessible to all users of the computer. 

Upload the Integration Module to an Azure Automation Account: 

1. Sign into Microsoft Azure. 

2. Open the Automation Account that you want to upload the module to. 

3. Click Modules under Shared Resources. The list of installed modules is displayed. 

4. Click Add a module at the top of the list. 

5. In the Upload File box, select the Kelverion.Zendesk.zip file that you download. 

6. Click OK. Importing the module make take several minutes. 

  

https://www.powershellgallery.com/packages/Kelverion.Zendesk
https://portal.azure.com/
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Licensing the Integration Module 
Licenses for Kelverion Integration Modules are managed and deployed using Kelverion Runbook 
Studio and Automation Connection Assets. 

Register an Integration Module license with Runbook Studio: 

1. Open Kelverion Runbook Studio. 

2. On the File tab, click About. 

3. Click License Information. 

4. Click the Integration Modules tab, and then click Add License. 

5. Select the integration module license file (*.kaml) and click Open. 

6. You should see your entitlements displayed in the list. 

7. Click OK. 

 
Important: Entitlements will not display until after the Integration Module has been installed on the 
Runbook Studio computer. 

Create a Connection Asset with a license key and upload it to Azure: 

1. On the Home tab, click Sign In. The Sign In dialog appears. 

2. Sign into your account. 

3. Select the Automation Account that you want to update. 

4. Click New Asset and then click Connection. The New Connection dialog appears. 

5. In the Name field, enter a name to identify the connection. 

6. In the Connection Type field, select the desired connection type. 

7. Enter the appropriate connection information in the provided fields. 

8. Click OK.  
Update all Connection Asset license keys and upload them to Azure: 

1. On the Home tab, click Sign In. The Sign In dialog appears. 

2. Sign into your account. 

3. On the Explorer panel, click the Azure (Online) group. 

4. Right-click the Azure Automation Account that contains the connection assets you want to 
update, and then and then click Update License Keys. A summary is displayed.  
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Working with Activities in Runbook Studio 
The following sections outline some of the common configuration options that are available to you 
when working with the activities in the Kelverion Integration Module for Zendesk. 

The Kelverion Integration Module for Zendesk supports the following activities. 

Get-ZendeskComment Get the comments on a ticket. 

Get-ZendeskRecord Get a record. 

New-ZendeskTicket Create a new ticket. 

Remove-ZendeskTicket Delete a ticket. 

Set-ZendeskTicket Modify an existing ticket. 

The advanced discovery capabilities provided by the activities in this integration module are only 
supported when authoring runbooks in Kelverion Runbook Studio. 

When you publish your runbooks from Kelverion Runbook Studio to Azure Automation or when you 
generate PowerShell code snippets for Service Management Automation, Runbook Studio will 
automatically convert the dynamically generated parameters and filters of Smart activities into the 
parameters provided by the underlying command activities. 

Smart Connections 
In Kelverion Runbook Studio you can configure one or more Smart Connections to establish reusable 
links between Runbook Studio and specific Zendesk subdomains. You can create multiple Smart 
Connections to the same subdomain to allow for different user accounts. 

Add a Smart Connection in Kelverion Runbook Studio: 

1. On the Home tab, click Smart Connections. The Smart Connections dialog appears. 

2. Click Add a connection at the top of the list. 

3. In the Name box, enter a name for the connection.  

4. In the Connection Type box, select Kelverion.Zendesk. 

5. In the SubDomain box, enter the subdomain for your Zendesk instance. You can find this in 
your Zendesk instance URL, which is based on the format 
https://<subdomain>.zendesk.com. 

6. In the Username box, enter the username that the integration module should use to 
connect to your Zendesk instance. 

7. In the Token box, enter the API token that the integration module should use to connect to 
your Zendesk instance. For more details on how to generate an API token please refer to 
Zendesk documentation. 

8. Click OK, and then click OK again. 

https://support.zendesk.com/hc/en-us/articles/226022787-Generating-a-new-API-token
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Global Connection Assets 
The activities in the Kelverion Integration Module for Zendesk require connection information to 
connect to instances of Zendesk.  

The recommended way to pass connection information to your activities in your runbooks is to use 
Global Connection Assets. Global connection assets let you securely define connection information in 
Azure which can then be retrieved on demand using either the Get-AutomationConnection cmdlet or 
Connection Asset Data Source. 

Add a global connection asset in Runbook Studio: 

1. On the Home tab, click Sign In. The Sign in dialog appears. 

2. Sign into your account. 

3. In the Active Azure Automation Account box, select the account that you want to add the 
connection asset to. 

4. Click New Asset and then click Connection. The New Connection dialog appears. 

5. In the Name box, enter a name for the configuration.  

6. In the Connection Type box, select Kelverion.Zendesk. 

7. In the SubDomain box, enter the subdomain for your Zendesk instance. You can find this in 
your Zendesk instance URL, which is based on the format 
https://<subdomain>.zendesk.com. 

8. In the Username box, enter the username that the integration module should use to 
connect to your Zendesk instance. 

9. In the Token box, enter the API token that the integration module should use to connect to 
your Zendesk instance. For more details on how to generate an API token please refer to 
Zendesk documentation. 

10. Click OK. 

Activity Properties 
All activities in the Kelverion Integration Module for Zendesk have the following properties: 

Property Description 

Label A unique label that identifies the activity in the runbook. Runbook Studio will 
provide a default name for each activity, but you can provide your own labels to 
make their role in the runbook more obvious. 

Description An optional description of the activity. Providing a description is a great way to 
let everyone understand the function of the activity in the runbook. 

Checkpoint Indicates whether or not a checkpoint is set in the runbook workflow after the 
activity runs. Checkpoints are only available for Graphical PowerShell Workflow 
runbooks. 

https://support.zendesk.com/hc/en-us/articles/226022787-Generating-a-new-API-token
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If the runbook uses Azure cmdlets, you should follow best practices and follow a 
check-pointed activity with an Add-AzureRMAccount in case the runbook is 
suspended and restarts from this checkpoint on a different worker. 

Smart Discovery 
When designing runbooks in Kelverion Runbook Studio, you will notice that the activities in the 
Kelverion Integration Module for Zendesk include a Discovery panel instead of the Parameter Sets 
panel that is present for standard command activities. This is because the activities in the Kelverion 
Integration Module for Zendesk support interactive discovery of the Zendesk assets in your 
environments. 

All activities in the Kelverion Integration Module for Zendesk have a Connection option on the 
Discovery panel which lets you specify how Runbook Studio should connect to Zendesk. 

When connected to Zendesk, Runbook Studio will provide additional discovery options for some 
activities, Record Type which can be used to specify the resources that you want to integrate with. 
Once you have filled in the discovery options Runbook Studio will provide additional parameters and, 
in some cases, filters which can be used to configure the activity. 

Smart Parameters 
Unlike standard command activities, whose parameters are determined by the Parameter Set that is 
selected, the parameters in the Kelverion Integration Module for Zendesk are determined by the 
Discovery options that you specify.  

For example, when using the Get-ZendeskRecord activity, the Discovery panel will contain options 
for selecting a Zendesk record type. Once you have selected a record type, Runbook Studio will 
provide you with parameters that coincide with the fields in the business object. If you select 
another business object, Runbook Studio will provide you with a different set of parameters. 

You must configure all mandatory parameters. To view the optional parameters that are associated 
with an activity, click Optional at the top of the Parameters tab.  

In addition, all activities in the Kelverion Integration Module for Zendesk include a Connection 
parameter which is used to specify information that the activity will use to connect to Zendesk when 
it is executed as part of a runbook running on a Hybrid Worker. Typically, you will assign a 
Connection Asset data source to this parameter so that the activity can securely use connection 
information stored in Azure.  

The Connection parameter should not be confused with the similarly named Connection option on 
the Discovery panel which is used to specify how Runbook Studio connects to Zendesk in order to 
provide design-time configuration options. 

Several factors determine the data sources that are available when configuring a parameter. They 
include: the parameter's data type, whether it is linked to another activity and whether the runbook 
has any input parameters. 
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Runbook studio supports the following data sources. 

Data Source Description 

Activity output Specify activity whose output will be assigned to the parameter. You may also 
provide an optional Path to select a specific property of the output objects that 
are generated by the activity. 

Available when the activity is linked to a source activity. 

Not configured Clears any value that was previously configured. You must configure all 
mandatory parameters. 

Certificate asset Specify the name of the global certificate asset that will be used to provide a 
value for the parameter. 

If you have connected to Azure and selected a Subscription and Automation 
Account on the toolbar, the data source will provide the names of the 
certificates that are available. 

Credential asset Specify the name of the global credential asset that will be used to provide a 
value for the parameter. 

If you have connected to Azure and selected a Subscription and Automation 
Account on the toolbar, the data source will provide the names of the 
credentials that are available. 

Constant Specify a constant value to assign to the parameter.  

Available for parameters that have the following data types: 

• String 
• DateTime 
• Timespan 
• Decimal 
• Double 

When assigning a constant DateTime and Time values, Runbook Studio assumes 
the value is in UTC. 

Connection asset Specify the name of the global connection asset that will be used to provide a 
value for the parameter. 

If you have connected to Azure and selected a Subscription and Automation 
Account on the toolbar, the data source will provide the names of the 
connections that are available. 

Empty string An empty string will be assigned to the parameter. Available when the 
parameter is type System.String 

Null A null ($null) value will be assigned to the parameter. Available when the 
parameter type is a reference type. 
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Smart Filters 
Some of the activities in the Kelverion Integration Module for Zendesk include a Filters panel which 
lets you specify filters that can be used to retrieve specific issues in Zendesk. 

To add a filter to your activity, select the Filters panel and click Add. Filters have the following 
properties. 

Property Description 

Filter The name of the filter. 

Operation The operation used to evaluate the filter. Different operators will be provided 
based on the filter that is selected. Possible filter operators include: 

• Equals 
• Does not equal 
• Is less than 
• Is less than or equal to 

• Matches 
• Does not match 
• Is greater than 
• Is greater than or equal to 

 
 

Value The data source used to retrieve the value to use to evaluate the filter. 
The value used to evaluate the filter will be obtained. For more information on 
data sources, please refer to the Parameters section for more information on 
configuring data sources. 

Retry Behavior 
The activities in the Kelverion Integration Module for Zendesk can be configured to run multiple 
times until a condition, which you specify, is satisfied. You can use the retry behavior options to 
configure activities that should run multiple times, that are error prone or may need more than one 
attempt for success. 

PowerShell 
expression 

Specify a simple PowerShell expression whose output will be assigned to the 
parameter.  

You can use variables in the expression to access the output of an activity or a 
runbook parameter. 

Runbook input Specify the name of the runbook input parameter whose value will be assigned 
to the parameter. 

Available when the runbook has one or more input parameters. 

Variable asset Specify the name of the global variable asset that will be used to provide a 
value for the parameter. 

If you have connected to Azure and selected a Subscription and Automation 
Account on the toolbar, the data source will provide the names of the variables 
that are available. 
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When you enable retry for an activity, you can configure the runbook to wait a specified number of 
minutes or seconds before running the activity again. If no delay is specified the runbook will run the 
activity again, immediately after it completes. 

The retry condition lets you specify a PowerShell expression 
that the runbook will evaluate after each time the activity runs. 
If the result of the expression is true the activity does not run 
again, and the runbook moves on to the next child activity in 
the runbook. 

When defining the retry conditions for your activity you can 
take advantage of a global variable called $RetryData. Specific 
information about the last time the activity ran can be 
accessed using the following properties. 

 

Property Description 

NumberOfAttempts Number of times that the activity has ran 

Output Output that was generated by the activity the last time that it ran 

TotalDuration Time elapsed since the activity was started 

StartedAt Time in UTC when the activity was first started 
The following are some examples of activity retry conditions 

# Run the activity exactly 5 times 
$RetryData.NumberOfAttempts -eq 5 
 
# Run the activity until it produces some output 
$RetryData.Output.Count -ge 1 
 
# Run the activity until at least 2 minutes has elapsed 
$RetryData.TotalDuration.TotalMinutes -ge 2 
 

Additional Parameters 
The activities in the Kelverion Integration Module for Zendesk let you specify additional PowerShell 
parameters that you can use to control the behavior of the activity.  

For example, to output detailed information about the operation performed by an activity you would 
specify -Verbose:$True 
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Get-ZendeskComment 
The Get-ZendeskComment activity retrieves all the comments on a ticket.  

Discovery Options 
You can use the following options to connect to Zendesk and configure the activity: 

Connection The name of the Smart Connection used to connect Runbook Studio to 
Zendesk. 

Required Parameters 
You must configure the following parameters. 

Connection Hashtable containing information used to connect to Zendesk. 

Ticket ID The ticket ID of the ticket to retrieve comments. 

Optional Parameters  
You can use the following optional parameters to control the behavior of the activity: 

Ascending Indicates that comments should be sorted in ascending order. 

Output 
The activity returns objects that represent the Zendesk comments that were retrieved. 
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Get-ZendeskRecord 
The Get-ZendeskRecord activity retrieves Zendesk records using criteria that you specify. 

Discovery Options 
You can use the following options to connect to Zendesk and configure the activity: 

Connection The name of the Smart Connection used to connect Runbook Studio to 
Zendesk. 

Record Type The type of record to retrieve. 

Search By The method used to retrieve the records. Select Filters to use filters, Record 
ID to get by record ID or Query to use a query. 

Required Parameters 
You must configure the following parameters. 

Connection Hashtable containing information used to connect to Zendesk. 

Record ID The record IDs of the records to retrieve. 

Optional Parameters  
You can use the following optional parameters to control the behavior of the activity: 

Ascending Indicates that records should be sorted in ascending order. This parameter is 
used only when Order By is specified. 

Order By The field used to order the records by. 

Filters 
The activity provides filters based on the Record Type that was selected. 

Output 
The activity returns objects that represent the Zendesk records that were retrieved. The record type 
you selected during discovery will determine which properties the objects will have. 
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New-ZendeskTicket 
The New-ZendeskTicket activity creates a new Zendesk ticket.  

Discovery Options 
You can use the following options to connect to Zendesk and configure the activity: 

Connection The name of the Smart Connection used to connect Runbook Studio to 
Zendesk. 

Required Parameters 
You must configure the following parameters. 

Connection Hashtable containing information used to connect to Zendesk. 

Comment The first comment of the ticket. 

Optional Parameters 
The activity provides additional parameters based on the subdomain that you selected.  

Output 
The activity returns the ID of the Zendesk ticket that was created. 
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Remove-ZendeskTicket 
The Remove-ZendeskTicket activity removes a Zendesk ticket.  

Discovery Options 
You can use the following options to connect to Zendesk and configure the activity: 

Connection The name of the Smart Connection used to connect Runbook Studio to 
Zendesk. 

Required Parameters 
You must configure the following parameters. 

Connection Hashtable containing information used to connect to Zendesk. 

Ticket ID The ticket ID of the ticket to remove. 

Output 
The activity returns the ID of the Zendesk ticket that was removed. 
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Set-ZendeskTicket 
The Set-ZendeskTicket activity modifies an existing ticket.  

Discovery Options 
You can use the following options to connect to Zendesk and configure the activity: 

Connection The name of the Smart Connection used to connect Runbook Studio to 
Zendesk. 

Required Parameters 
You must configure the following parameters.  

Connection Hashtable containing information used to connect to Zendesk. 

Ticket ID The ticket ID of the ticket to modify. 

Optional Parameters 
The activity provides additional parameters based on the subdomain that you selected.  

Output 
The activity returns the ID of the Zendesk ticket that was modified. 
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